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1. #7JF Launcher, #F|TAEH4%: E:\HM_Solution, ¥ CSA.cmp %] cMOST E¥r, FTJF CMOST
A, SRJGEY#3] Control Centre -> Experiments Table
2. KB HIFEEI GlobalHMError. midiFlIFRLHAT I, XMEHLREE 2P R 2 MEE &Ik

HEZ, MG B s B SR 30 7 R A f BTk R AULA RS P A v A, )ﬁﬁidﬁ?%ﬂ, T
A,

3. 7E Builder H1, f&ifF Well -> Group New

4. WSINJEARS, S AMEAIBAE RSP 5 g AT EEAR NS 2 AH R
Bt gl 4208 Field , SR )5 25 i 4441 Add New Group
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Definition
Production
Name: | Field I
Injection
Parent group: [(Nonem‘his i a topdevel aroup V]
Muttipliers -
The parent can be either top level group ora
T 2nd level group with no wells attached.
Apportionment Attach Wells ...
Guide Rates Flease note:
- defining the topdevel group and no child group defined yet. No constraints can be defined at the
moment. To proceed with constraints, etc. you need to define at least one child group at the
selected date.

Simulation start date: 2005-03-25

Defirition date: 2009-09.25

o ) (oo ]

5. TN gunFd css, ARG s oK.

Definition
Production | i
—_—  Name: Css
Injection
Parent group: [Fleld =
Muttipli
Liiee The parent can be sither top level group or a
Monitoring 2nd level group with no wells attached.
Appottionment Attach Wells ...
Guide Rates

Simulation start date: 2009-09-25

Definition date: 2009-08-25

[ Addrew growp | [ ok [ Goameal J[ koo |

’

6. N ASHBIN, ARG REMIEAN B A . st Well -> Group Events
7. Wafkikdr css H4l, SRJE S 4l Attach Wells. %3 njector 1 #1 Producer 1 ij [ 5 i HE,

SRJA s i OK.
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B | Well-Group Attachment =
Zndlevel group TSS™ 2t 20030925 000 daf) i, defined al 20080525
Name / Date Event Definition Group definiion ~ Previous date: <none> ([ Auto-Aoply Changes SRy
! - .
TITEE e Production T — e NOTE: * - the wel definition event. Its date can not be modified
L Injection i Er:lry Dete | Group ‘
20030925 GROUP = Parentgoun: g - N | 20030325 55
phaeles The parent can be sthertop level group or 3 x |7 LE H050525 £58
Monitoring 2nd level group with no wells attached '
Apportianment
Guide Rates |
Auttodril
Recycling
Manfolds '
Options
Cycling Group I
Comments
Check Highlighted Everts | [ Un-check Highlighted Events | |
s @ e i ) et
Tz

B H BN 2012-09-25 , 4R )5 Hiili Cycling Group.
9. f{f Participating Streams (CYCLESTREAMS)i} 47, #i{R{i%+F Production fll Water Injection .

10.

% & Cycle Part Number (NPARTS) N 3 .

EZER Iy E XA “value 17 NIENERSY (Injection period) ; %1 “value 2” NdFH#E45> (Soak
period) ; %] “value 3” N4 774> (Production period) .

11.

W & FTH Water Injection y STW — Stock Tank Water

HABATT LUK FE .
12,

1% Stream Maximum Rates §ij [f] 5 & HE

fE Production T, #iA 1000 ({XLEZE=%1)
7E Water Injection [, FiA 1000 ({XFEZE—51)

7 Stream Target Types, & /T Production 24 STL — Stock Tank Liquid

YER: 52 IIREHIE BN B R TEARILTZ

13.

WAH V2 HAhIETT (other options ) HSRIEGIIEIAA . 7EZF 5, A TR EEA FFr BT

BRI . 7Bl 7, BATEFEBEN . WHAEBKE . S$3 Max Cycle Part
Duration, %" Add/Remove Ei%EHE, RGN EME 10, 7 1348,

14,

N T 38 e AE 25 A B BORA LA P IR HR BSOS 1), 7 BEAE BN B BOS I/ 46 1

[a]2F K. fE Starting Time Step Size, & Add/Remove Fjlfi & iEHE, FERE—%2 B4

0.0001. 0.0001 /% 0.0001.
1

w

- Kkt Apply TRAFIRE . AN AN EPR. 58mUa s OK.
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r ™
1 | Group Events E@g

2012-05-25 vI 2nd level group 'C55" at 2012-09-25 (1096.00 day)

MName / Date Event Definition Participating Streams {CYCLESTREAMS): I Production Water Injection I
css T | Gas Injection Solvert Injection
2003-09-25 GROUP | Fodsion Cydle Part Number (NPARTS):
Injection
Field = —  Event: [Deﬁne Cycling Group Control v] Edit Event
2009-05-25 GROUP Multipliers
——— | subkeyword Edt | value 1 | value 2 | Value 3 |
Monitoring Stream Target Types
Apportionment | progy,ction I STL-Stock .. ZJ STL-Stock .. ZJ STL- Stock .. Lll
Guide Rates Water Injection STW - Stock... 7| STW - Stock... 7| STW - Stock... 7|
Autodrill Gas Injection STG - Stock Ta... STG - Stock Ta... STG - Stock Ta...
Recycling Stream Maximum Rates Add/Remaove
| T Vowfode | Production 0 bbl/day 0 bbl/day 1000 bbl/day
P Water Injection 1000 bbl/day 0 bbl/day 0 bbl/day
@ Gas Injection 0ft3/day 0ft3/day 0ft3/day
Inj Stream Voidage Repl. Frac. [ Add/Remove
Commerts | Water Ijection 0 0 0
Gas Injection 0 0 0
Max Cum Production/Injection
Production 0] Add/Remove Obbl Obbl Obbl
Water Injection 0] Add/Remove Obbl Obbl Obbl
Gas Injection O Add/Remove 0ft3 0ft3 0ft3
Max Cum Heat Injection
Water Injection O Add/Remaove 0 kW-hr 0 kW-hr 0 kWhr
Gas Injection O Add/Remove 0 kW-hr 0 kW-hr 0kWHhr
Max Bottom Hole Pressure
Water Injection O Add/Remove 0 psi D psi Opsi
Gas Injection O Add/Remove 0 psi D psi Opsi
Min Inj Rate for Cycle Switching
Water Injection O Add/Remove 0 bbl/day 0 bbl/day 0 bbl/day
Gas Injection O Add/Remove 0ft3/day 0ft3/day 0ft3/day
Other Options
Max Cycle Part Duration ] Add/Remove |10 day 7 day 348 day
Starting Time Step Size Add/Remove 0.0001 day 0.0001 day 0.0001 day
Min Bottom Hole Pressure [ Add/Remove D psi D psi Opsi
Min Qil Rate for Cycle Switching [0 Add/Remove 0 bbl/day 0 bbl/day 0 bbl/day
Min Depletion Index for Cycle Switching [ Add/Remove 0 0 0
Tot Number of Cycles Have To Complete [0 Add/Remove 0

S e = |

16. TEJ7 SLHNE B BOR ], EANFRR M. FEWET, FETFXeEH. Al well -> well
Events. f{RIET Injector 1, SR/5¥s HIAYI ¥ B iR f5 — MW AL 2012-09-25

17. siil7 Options br%8. % Status AT IS IEHE, SRJ51EFE OPEN. £iili Apply.

18. A7 Constraints ¥R, % Constraint Definition EiEHE, 7 Apply 2RJG OK.
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™
=

F: Producer 1 ZJ R 252 5E 0T, AT B
AV T 20 4F, FHFEFIMSINAEH .

19. fi i Well -> Dates
A i Add a range of dates %41 .
From: 2012-09-25
To: 2032-09-25
Step: every 6 Months 2} )5 5 i OK

4 |
Select a range of dates Iﬂ

Fom:  [2012-09-25 (1096.00 day)

To: (20320925 (8401.00 day)

Step: E QK
Selected dates in the range: 41

\ —

20. HET, KT STOP ZEAEHL H 1 5 2012-09-25 J5 1, #FRFZH A, ¥ Set STOP H{#x 5
£, ARG H IS 2032-09-25, 4 Set STOP X b ) H ik HEFT X5, i Close , iBHi.

RN T A AL 25 SRER /& M 2012-09-25 FH46, FrPARAT R ERIEE S ), XFEERTA & T
W5 e A% ] s 5

21. & 10 Control -> Restart
1% Enable restart writing Fif [l 5 & HE .
sty EB L, U A R SR
PR H H 2012-09-24 SR 5 25 OK.  CH R AR I3 sE 4004wl T — AN ) )
&5 Writing Frequency Option 4 One record per TNEXT keyword occurrence (TNEXT)ZR J5 &
i OK.
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Reading Restarts

Restart from previous simulation run (RESTART)
Simulation output file to restart from:

Record to restart from: |

Enable restart writing
L OMBer of Testart records stored ("REWIND)

Restart Writing Frequency (WRST) View/Edit TNEXT Dates

Date/Tme _ |\iting Frequency Onfions Yalue |
20120924 |[One record per TNEXT keyword occurrence (TNEXT) ] = |

22. A5 File -> Save As

XL E, EEEAN TR H S CSA.cmpd , TEJRH CAFL RS B s
“ Forecast.dat’. &/, ridi OK.

r ™
" Save Dataset l P J
‘Comments for the dataset (top of main file):
CHMOST_PARAMETER Porosity 0.2530303 -
CMOST_PARAMETER kvkhRatio 0.41868687

2017-07-06, 10:49:49, cmg
2017-07-07, 11:00:57, cmg

-

Main file: EMOP_Solution\CSA cmpdiHM.cmsd'HM_00093_Forecast.dat E
D Save the file to temp folder on local drive first, then copy the whole file to remote destination

[[Juse include fies Retain current binary structure

Text array method: | Default — Apply binary array compression to whole dataset

Remove compression and save in ASCI format

23. RAE S, G HEIT Launcher #2474 STARS HEf st Tie® (ffifH 1 AMabmEs) . 7F
Results Graph KiF Al g B, T EEFTEAEHIHZE A A E,
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24. [81%] Builder, il 10 Control -> Restart.

25. ¥ Restart from a previous simulation run (RESTART)Hil [ & iEAE .
edt.irf 3CF, 85 i OPEN
/£ Record to restart from H11%£ ¢ 2012-09-25
# Enable restart writing & IEHEHH X 5 L5, A5 i OK, 1B .

Reading Restarts
Restart frem previous simulation run (RESTART)

Simulation output file to restart from:

EAOP_Solution\CSA. cmpdiHM_00093_Forecast.irf

Record to restart from: [201 2.05-25, 1095.0000 day, time step = 2254

Writing Restart
[ Enable restart wr'rting*-“

Maximum number of restart records stored (*REWIND |1

Restart Writing Frequency (WRST) Wiew/Edit TNEXT Dates

Date/Time | Writing Freguency Options | Yoo |

0K ][ Cancel ][ Help

SR T XM AHERE R . BATTKEE w4 . Pt A ESRAVATsgs .

26. sl File -> Save As
XFFAEEs AR, EBFEE TR HF CSA.cmpd, RJGTE A4 FR G “_Forecast.dat” {5 N

“_Optimize.dat” . 5EfJE, st OK.
27. fRF7 )G, 18It Launcher F HARAZ LRI STARS HEZ 5 .

FTIT log SCAFBSAFRIANAE A, U H BN %2 A 2012-09-25 FF46, AN 2 NS a6 ka6 H 1.
BT Results Graph i —DICUEBIUSE R, HEHEHETMIHIL R —2.

B1) % CMOST 4%

FATC 277 ROUACRE TSR . oS ERNME L 1 St A, JF BAE Rt ANF,
FT EAERATTHE 2 B T CMOST LA,

28. f£ CMOST 1, KIHAMFTAIH , X LR EE T H & 2% 5

29. FETHE IS A (Study Manager) , fiili New Sudy #2450, Win—A5iH .
o KHdr% N oP
o HHTINELALA
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o KRS BAUE NN Optimization ZR )G, i OK.

ﬂ MNew Study | = 2

~Required information for new study

Mame: OP (] Master study

Base dataset: E\OP_Solution\CSA.cmpd\HM.crmsd\HM_00093_Optimi: Bl Browse

Automatically create master dataset ((CMM) using the base dataset

Type: [ Optimization - ]

Advanced Settings | v

|@Dt{ |l®Cance| J

“1E“ Studies”{T- 55 & FLIX N 1ZAEHE 21 OP “Khx .

-Studies

EA HM opP

30. X ifi“ €SS Optimization “E 4%, 1]#: %] General Properties 51 -

e Sidi“Base session file relative path” &t Browse %4l . i%F% Engineer.ses.

o EWYMEEMS, Mili Import FHF #5H, i%4% ¢SS_BHP.fhf F1 CSS_Prodinj.fhf %4 5 ih
Open.

31. Y)#:3] Input -> Fundamental Data -> Original Time Series
o miili Insert, WSHIUATR B [E] P51 HH 28

Origin Type Origin Name Property

WELLS Producer 1 Cumulative QOil SC
WELLS Producer 1 Cumulative Water SC
WELLS Injector 1 Cumulative Water SC

32. YJ# % Input -> Parameterization -> Parameters

10
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FERAG T 7 BB R S H, X SEURIE AT S A AR S A

33. St Edit %41, TIF“CMOST CMM Editor” . FATTAEE B IS EAE I sh A KB E 7 .

34. T HORBE LI LR, T T AR A W SR Information After Last
Date

35. [l BB, HEPSCH T MAXTIMES. 5% v M S I A AUE R 4 ik A B B A i
K. SR —FI B RN E], 25 ZHIRRIRIEIS 18], 58 = IR AR = A o

36. Add CMOST parameters each of the values associated with JyJ<4# 7 MAXTIMES )5 [l F£UE
i CMOST 24, kP REAKUME, A8, 1%+% Create Parameter

¥ 505y 5 4 N injectiontime.  soaktime /% productiontime.

N\

17.1918@187

WSRF GRID TIME

TIME 1096

INJECTOR MOBWEIGHT IMPLICIT 'Injector 1'
INCOMP WATER 1.8 2.9

3 TINIW 458.@

3574 QUAL @.7

3575 OPERATE MAX BHP 1884.5 COWT REPEAT

RO
NSN3 @
WM e e Do

3576 OPERATE MAX S5TW 58€8.8 CONT REPEAT
3577 OPEN 'Injector 1"

3578 GCONCYCLE_START 'C55°

3579 CYCSTREAMS 'PROD' 'WATI®

3580 NPARTS 3

3581 TARGETTYPES

3582 'PROD' 'STL® "STL' 'STL®

3583 "WATI' 'STW' °"STW' "STW'

3584 MAXRATES

3585 'PROD' 9.000000 @.000080 1003.020009

3586
3587 IMAXTIMES [10.600080] -injectiontime [7.000000] -soaktime [348.000000] -productiontime I
3588 g C g

8!

3589 GCONCYCLE_END
3590 TIME 1277

1 TIME 1481

92 TIME 1642
3593 TIME 1828
3594 TIME 20@7
3595 TIME 2191

SERA, MR, B H SR E CMOST FH
sy Import, SRJEHHE, ZEUHE B INEE] CMOST FHi .

SRR A W DUE T R AL SR AR R LA b E R VEE) 25%. AR T i ms iy Hfs, =
WHEE S HBUE

Parameter Lower Limit Upper Limit
InjectionTime 5 60
SoakTime 5 30
ProductionTime 90 1095

11



CG

%64 #: CMOST HE{E Sl 2 ik

37. DRAT 4 HT IS S0
K TXTHEE G-, BT AT (NPV) (EX HERERE . FETEIA , EITEA 3 H
KA B HI VTP 10%
LG Z Hi > e T G — T2 T ], FF 2012-09-25 124 0MIREZE 7 o
38. P]#:3 Input -> Objective Functions -> Characteristic Date Times
39. 7F Fixed Date Times #4), .7 Insert %41,

e {14 ForecastStart i} [A]
o FHIAKE N 2012-09-25T00:00:00

B cMOST -- EAOP_Solution\CSA.cmp [=|&@] = |
File Settings Tools Help
B aa G A& (7]
[study Manager [sA  [HM  |[oOP= x| =
4 ‘PpInput || -Builtin fixed date times
{:. General Properties Name Date Time Value
4 1 Fundamental Data 1 |BaseCaseStart 2009-09-25 T00:00:00
13 Original Time Series 2 |BaseCaseStop 2032-09-25 T00:00:00
Y/ User-Defined Time Series Focedt date fimas
{7 Property vs. Distance Serie Time Value ) Insert |
{= Fluid Contact Depth Series 1 |Forecaststart 2012-09-25 T00:00:00
Delete

4 X Parameterization
[ Parameters
& Hard Constraints

B3 Pre-Simulation Commands|=

4 e Objective Functions (- Dynamic date times from original time series
Characteristic Date Times Name Condition Critical
Value
Al Basic Simulation Results
{@ History Match Quality

Origin
Type

Origin
Name

Property || Qs

Delete

Search Start

Jccurrenc

753 Net Present Values

40. Y)#: 3 Input -> Objective Functions -> Net Present Values
41. {£ Unit Label, 157 N$
42, i Insert $4H, IS IGET H AR R
¥ FH Ay 4N OilRevenue
e ¥ H Unit Label ~N“$”
¢ & NPV Present Date & ForecastStart
e % & Property Filter ¥ Monthly Rate
43. 1EJCHES, sk Insert 4280, B IN—N50 H AR R £

e Origin Name: Producer 1

e Property: Oil Rate SC — Monthlyy
e Start Time: ForecastStart

e Unit $ Value: 70 ($/STB)

F A TR P R E

A4, NWEERRA, BE ERSE, T, A insert #2411, IIn—AN8 Hbreg$.
o JH w4 N SteamCost

12
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e % E Unit Label H“$”
e B NPV Present Date &y ForecastStart
e I Property Filter {24/ Daily Rate.
45, {EJEHS, i idi Insert 3N IN—ANHT H AR BR 2O .
e Origin Name: Injector 1
e Property: Water Rate SC — Daily
e Start Time: ForecastStart
e Unit $Value: -4 (S/STB. TA{HF /R~ H)

F A TS FH R

Field NPV definition
Field NPV name: Unit label: Calculation method:

FieldNPV $ Sum of Active Local MNet Present Values

Unit Label Calculation Method

Name MPV Present Date Property Filter

o Insert
1 |QilRevenue $ ForecastStart Monthly Rate Sum of Net Present Value T|

2 |SteamCost § ForecastStart Daily Rate Sum of Met Present Value TI @ Delete

Continuous Cash Flow Terms | Discrete Cash Flow Terms|

?;E" Origin Name Property Start Time End Time ;?::Erunt Rate | Unit Value E:C"t‘::“i"“ © Insert
1 |WELLS Producer 1 il Rate SC - Monthl|ForecastStart  |BaseCaseStop 0.1 70 1|| @ Delete
£ Repeat
46. Save {155
47. Y]#:3| Control Centre -> Engine Settings. 1155957 £ 1% %y Optimization, Engine Name
%+ CMG DECE

1E Optimization Settings, & Total Number of Experiments “4 100.

1E Global Objective Function Name, ¥ & FieldNPV.

1E Search Direction, 1% & Maximize.

7E Experiments Management, 1% & Number of Perturbation Experiments for Each Abnormal
Termination vy 2. 7EZEGIH, W TEEEHIEK, BAHIAKE, CMOST Kl —
MRPAR LI T, ReizF s .

48. 1J]#:3| Control Centre -> Simulation Settings.

13
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fif’ scheduler £ F% Local, J1E Active [ IEMEFT ). 1% & Max Concurrent Jobs /J 3.
WPRIEH STARS BOHTIRA . RUONFRA VA RIS F I ] /NT 1 708, B CAIRATTH Max
Run Time per Job % & N 0.1 /NIF (6 7351

~Schedulers: Connected using schedulers in Launcher. Please do not close Launcher when the study is running.
3 Refresh
Scheduler o Max Failed Job Additional | Host
ACE Name R7ZE jl:lz\scurrent Jobs picriblan Priority | Switches Computer
1 Local Local 3 25| All Time Low
~Simulator settings ~Job record and file management
Simulator: STARS Delete
Clear v
Simulator version: |2016.11 - Job Status | Job relete .dz | delete lo fles(irf,
Record * ek }'
MNumber of CPUs per job: |1 - — ——
MNormalTern
Method to find executable: |Find Exact Version =
AbnormalTe | ]
Max run time per job (hours]: Eailed & m m
dditional simulator switches: Killed
\pply simulateor license multiplier:
Write SR files on execution host: 1. For normal termination jobs, the user can specify the
. . . number of optimum experiments to keep simulation files
Write log file on execution host: [[] in Engine Settings page.
sable restart records writing: 2. Abnormal termination jobs are jobs terminated by the
sable arid records writing in OUT: 5|mu|:atorldue to nlumerlcal problems. .
. 9 i N 9 . @ 3. Failed jobs are jobs that couldn't run to completion due
isable grid records writing in SR2: ta hardware/software/license nroblems.

49. e, M Save.

50. fiil7 Control Centre iifi, i @ 4240135 CMOST 314,
CMOST H4 TFUa G TR, AR5 SR AT A R S8 HEATHE 41

CMOST %5538 N 80 #r

CMOST iafT— B G, BEHBIER, TATTLUEZIRRISE 1 NPV, S8T, A1
BEXFREMIIN TR, HIEARTEZN 60 K. MFATEEZICKE FieldNPV vs. Injection time
i, FRATAT LA HEARES NPV Z (B IEAH S o X AT DU i ACEE 43 B WXL A5 21 38 IE
M, AR KRN RS, mT gk —28 o8 NPV,

14
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FieldNPV ($)

3.4E+006
3.2E+006
3.0E+006

2 BE+006
2. 6E+006 o

2.4E+006 /

2.2E+006 L]
//
2.0E+008 =

1.8E+006
1.6E+006

1.4E+006
5

51.
52.

53.

54.

l General Solutions ~ 4p Optimal Solution () Base Case

10 15 20 25 30 35 40 45 50 55 60 65
iniectiontime

7t Control Centre 5[, 151k CMOST 5/%¢,
{#1k51 % )5, A% Study Manager Ft1, 2AJEEH1E5 OP, 4% i Copy to new Study,
BHAa 48 oP_2, AJEH NZAITSS, VI3 Input -> Parameterization -> Parameters
HFEZ K InjectionTime, % HAHUE YL [ :

TRR: 50

BR: 250
{RIFAESS, SRJG A5 Control Centre JA %51 %, HikizH.
1E Engine Settings ', % & Total Number of Experiments }J 200. CMOST iz & 525, &
L
7] ¥ | Results & Analyses -> Objective Functions -> Run Progress K& NPV & Wi i3 K] .
Al LA R R 218U E TG B e f5, 3 NP B N.

[ General Solutions 4 Optimal Solution .Basecase]

4.6E+006
4.4E+008 . 4
4.2E+006
4.0E+006 |
3.8E+006 I
y N
| AR
3.4E+006 -
& |
2 3.26+006-]
2 \'4
2 2.0E+008--~
=
© 2.8E+006
w
2.6E+006
2 4E+006
2.2E4008
2.0E+006{
1.8E+008
1.6E4006
1.4E+008
20 40 &0 80 100 120 140 160 180 200 220

Experiment ID

15
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55. YJ# 3] Results & Analyses -> Objective Functions -> Cross Plot Zr & H Fr i $5 HAth A & 2 [A]
KA.
7 FieldNPV B2k, 1%E#F InjectionTime. FHEVENBTEAIHEIN, NPV WG K, SR, 24iE
NS Rt S —AE s, BEE B A3 I0, NPV T8N

[ General Solutions  4p Optimal Solution @) Base Case

46EH006
44E4006
42E4006 _ -
4.0E4006 -
3.8E+006 -
26E4006
5 L4EHe
S S2E+006
L 3.0E+008 Z
3 2864008
i 2E4008
2454006 /.
2264006 @ -4
20640061/
1.8E+006
1.6E4006
1.4E4008
0

&
_—_—V—\

\

20 40 60 80 100 120 140 160 180 200 220 240
injectiontime
56. 1]#:%] Results & Analyses -> Time Series -> Observers £r &1L 45 B FEAT R 2L i 2. 5
FERTT AR, BT RERA A . 4AR, AR E 2, FNtHSEE 2
HIR

Cumulative Oil SC — Producer 1

I General Solutions  @Field History === Qptimal Solufion =====Base Case

2.2E+005

2.0E+005

1.8E+005

1.6E+005

1.4E+005

1.2E+005

1.0E+005

8.0E+004

6.0E+004

Producer 1 Cumulative Qil SC (bbl)

P //
20EH004 -
0.0E+000
2010 2015 2020 2025 2030
Time

57. YJ# 3| Control Centre -> Experiments Table
IS FieldNPV X RAS AT HE T B e 7 RS HHUE

16
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